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TUTORIEL 

 

CREATION DE PAYSAGE POUR 

ORBITER 2006p1 

 

 
 
 
Par Jekka 

Introduction 
 
Une des plus importantes lacunes d’Orbiter est le manque singulier de paysages à la 
surface des différents corps du système solaire. En effet, quoi de plus frustrant après 
un voyage de plusieurs millions de kilomètres que de se poser sur une surface 
désespérément plate et monochrome ? Pourtant, en mettant un peu les mains dans 
le cambouis, il est possible de créer en un minimum de temps un paysage 
personnalisé qui rompra la monotonie visuelle des atterrissages à la surface des 
corps célestes !  
 
Ce tutorial vous propose une méthode simple et rapide pour créer et ajouter des 
paysages dans orbiter, moyennant un minimum d’investissement et de persévérance 
de votre part. 



Tutoriel : Création de paysages – Par Jekka Orbiter 2006p1  
 

  2/26 

 

Avant de commencer 
 

Utilisation de ce tutoriel 
 
Vous pouvez tout à fait imprimer ce tutoriel pour plus de lisibilité. Il faut toutefois 
savoir qu’il contient plusieurs liens vers différentes pages internet utiles. Garder une 
version électronique à portée de souris est donc plus que recommandé 
 
Suivant le sujet abordé, le tutoriel offre des renvois à des fils sur le forum de 
Dansteph qui traitent de la problématique rencontrée. Il s’agit de complément 
d’information si vous voulez creuser le sujet, mais il n’est pas indispensable d’y avoir 
recours. 

Niveau de compétence 
 
Ce tutoriel, en particulier la première partie, s’adresse aux personnes qui veulent 
mettre des paysage dans orbiter, mais qui n’ont pas forcément déjà réalisé d’addon 
auparavant et qui n’ont jamais touché Anim8or. Cependant, un minimum de 
connaissances en retouche d’image avec Photoshop est nécessaire, ainsi qu’un peu 
de jugeote et de persévérance. Comptez y passer une bonne après-midi, par un 
dimanche pluvieux par exemple... ;-)  
 
La seconde partie considère que vous savez utiliser Photoshop et Anim8or sans trop 
de problème. Il s’agit d’un niveau plus avancé au niveau du tutoriel, mais pas au 
niveau de la complexité des taches à accomplir… 
  

Logiciel requis 
 
Un certain nombre de logiciels est nécessaire à la création de paysage pour Orbiter. 
Voici la liste de ceux utilisés avec ce tutoriel. Si vous êtes débrouille, vous pouvez 
tout à fait en utiliser d’autres, mais sachez que le résultat n’est garanti qu’avec la 
combinaison de softs proposée ici. 
 
 
Anim8or 
 

Il s’agit d’un programme de modélisation 3D gratuit. La prise en main est 
différente d’un 3D Studio Max, et les possibilités qu’il offre sont nettement plus 
limitée que ce dernier. Néanmoins, il suffit largement pour le travail qui nous 
intéresse, c'est-à-dire modéliser le relief du paysage. 
 
Où le trouver ? :   
 
A télécharger gratuitement sur http://www.anim8or.com/ 
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Adobe Photoshop CS 2 
 

Le programme de retouche photo par excellence. Différentes versions 
existent, mais il n’y a priori pas de différence significative au niveau du résultat 
final. Il servira à éditer et retoucher les images de la surface des planètes. 
 
Où le trouver ? :   
 
Adobe Photoshop est un logiciel sous licence. Il n’est pas légal de le 
télécharger gratuitement. A vous de vous le procurer. 

 
 
Plug-in NVIDIA DDS 
 

C’est un plugin pour Photoshop qui permet d’enregistrer les textures 
directement en format *.dds. Il permet également la création de couche alpha, 
mais nous verrons tout ça plus tard. 
 
Où le trouver ?   
 
A télécharger gratuitement sur ce lien :  
 
http://developer.nvidia.com/object/photoshop_dds_plugins.html 
 
Attention  ! Ce plugin installe ses fichiers dans les dossiers  Photoshop 
sous leur dénomination anglaise ! Si vous utilisez une version française 
de Photoshop, il faut les déplacer dans les dossier s à dénomination 
française !  (Ex. : dossier Ang = « File formats» → Fr = « Formats de 
fichiers ») 
 
 → voir thread sur le forum de Dansteph : 
 
http://orbiter.dansteph.com/forum/read.php?f=5&i=11764&t=10918#reply_11764 

 
 
3DS2MSH 
 

Il s’agit d’un petit programme créé par Vinka pour convertir les fichiers réalisés 
avec Anim8or en format *.msh, le format utilisé par Orbiter. Etant une 
application DOS à la base, une interface windows très pratique, 
3DS2MSH_GUI, a été réalisée par le frère de notre ami Mustard. 
 
Où les trouver ?   
 
A télécharger gratuitement sur ces liens : 
 
- 3DS2MSH :  http://users.swing.be/vinka/ 
    
- 3DS2MSH_GUI :  http://orbiter.mustard-fr.com/addons/3ds2mshfr.php 
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Addbase v1.1 
 

Ce petit programme créé par enricod servira à créer des bases dans Orbiter 
pour attacher nos paysages à la surface des corps célestes qui ne possèdent 
pas de site d’atterrissage. 
 
Où le trouver ? 

 
A télécharger sur Orbit Hangar :  
 
http://www.orbithangar.com/searchid.php?ID=942 

 
 

Sites sources 
 
Pour avoir un résultat réaliste, il faut à la base avoir des images de bonne qualité et 
de haute résolution.  
 
Le site du Jet Propulsion Laboratory en Californie propose une quantité 
impressionnante de photos de la surface des corps du système solaire en haute 
résolution. C’est un site de choix pour notre travail : 
 
http://photojournal.jpl.nasa.gov/Help/ImageGallery.html 
 
L’Université d’Arizona propose également des très belles images, mais limitées à la 
planète Mars : 
 
http://hirise.lpl.arizona.edu/katalogos.php 
 

En cas de problème 
 
Si vous rencontrez des difficultés ou que vous avez besoin d’éclaircissements, une 
seule adresse :   
 
http://orbiter.dansteph.com/forum/index.php 
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Au boulot ! 
 
Vous voilà équipé des programmes nécessaires, et vous avez en mains deux-trois 
bonnes adresses, vous pouvez attaquer ! Vous allez créer pas à pas un paysage 
destiné à la lune de Saturne appelée Japet . Orbiter étant en anglais, le nom utilisé 
dans ce tutoriel sera Iapetus , sinon il sera difficile de s’y retrouver ! 
 
La raison du choix de cette lune est que d’une part, elle ne possède pas de base 
dans Orbiter, et que d’autre part sa surface est singulière et le paysage en sera 
d’autant plus magique… 

Prêt ? Alors on y va… 
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PREMIERE PARTIE 

Travaux préliminaires 
 

1. Créer un dossier Orbiter 2006p1 vierge 
 
Préparez un dossier Orbiter 2006p1 dédié à vos créations. Il doit être vierge de tout 
addon. Vous éviterez ainsi de potentiels conflits avec des bases ajoutées par 
certains addons. De plus, vous éviterez de polluer votre dossier Orbiter habituel avec 
vos essais. Il sera également plus facile de retrouver vos fichiers dans les dossiers. 
 
Dorénavant, quand il sera question du dossier Orbiter ainsi que des dossiers qu’il 
contient (Config, Meshes, etc…), il s’agira toujours de ce répertoire ci. 
 
Activez au passage sur le panneau de lancement d’Orbiter le module ScnEditor sur 
l’onglet Modules . Cela pourra peut être se révéler utile par la suite 

2. Créer un dossier de travail 
 
Pour ne pas tout mélanger, créez un dossier Paysage dans votre dossier Orbiter. 
Vous y mettrez tous vos fichiers de travail pour éviter la gabegie dans le répertoire 
principal… 

3. Rechercher une image  
 
Sur le site du JPL, allez dans la section destinée à Saturne. Continuez sur Iapetus. 
En tournant les pages, vous devriez tomber sur cette image : 
 

 
 
Elle est idéale pour commencer. Le relief n’est pas trop compliqué, et la couleur est 
uniforme. Il sera relativement simple de l’insérer sur Iapetus. Téléchargez-la. 
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Création du paysage 

1. Créer une base 
 
Il va falloir maintenant créer une base comme point d’attache pour notre paysage. 
Décompressez le programme Addbase v1.1  dans votre dossier Orbiter et exécutez 
le. Le programme vous demande quelques informations. Entrez les paramètres 
suivants : 
 
1. Planet or moon : 
 

Iapetus  
 
 
2. Base name : 
 

Comme vous voulez… Disons P1 (c’est court ;-) ) 
 
 
3. Input method : 

 
Choisissez Manual Input 

 
 
4. Insert base location :  
 

Comme vous pouvez le constater, Iapetus a la particularité d’avoir un 
hémisphère sombre et un hémisphère clair. La photo choisie provient 
manifestement de ce dernier. La base se situera logiquement sur cette partie 
de la lune. Il faut définir la longitude (première valeur) et la latitude (seconde 
valeur) pour avoir une position correcte. Entrez donc ces valeurs : 60 18 

 
Voilà, Addbase vous a créé une base ! Qu’a-t-il fait exactement ? Si vous lancez 
Orbiter, vous remarquez qu’un scénario porte le nom de votre base, soit P1. Lancez-
le et vous verrez un Deltaglider au milieu d’un complexe astroportuaire à la surface 
de Iapetus, sur son hémisphère clair plus précisément !  
 
Maintenant, quittez Orbiter et jetez un coup d’œil dans le dossier Config.  
 
Ouvrez le fichier Iapetus.cfg avec le notepad de windows. Addbase a, comme son 
nom l’indique, ajouté une base sur cette lune. Cela se traduit par ces quelques lignes 
à la fin du fichier : 
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On retrouve les paramètres que l’on vient de rentrer : 
 
Le nom :  P1  
La longitude : 60 
La latitude :  18 
 
 

Vous pouvez modifier l’emplacement de la base ici. Attention, le Deltaglider ne suivra 
pas la base ! Vous devrez le resituer à l’aide de ScnEditor pendant que vous jouez le 
scenario sous Orbiter (Ctrl+F4 → ScnEditor→ Location). Pour le moment, ne touchez 
à rien et fermez ce fichier. 
 
Toujours dans le dossier Config, vous remarquerez que Addbase a créé un fichier 
nommé P1.cfg . Ouvrez-le.  
 
Dans ce fichier sont déclarés tous les éléments visuels composant la base. Chaque 
élément est défini ainsi : 
 

 
→ Type : BLOCK, marque le début de la description 
 
 
 
 
 
→ Marque la fin de la description, indispensable ! 
 

 
Retenez bien ce fichier car c’est ici que plus tard le paysage sera déclaré.  A ce 
niveau là, deux solutions s’offrent à vous : garder les éléments de la base dans votre 
futur paysage, ou n’avoir que le paysage vierge, sans les immeubles et les pistes.  
 
Si vous souhaitez les conserver, ne touchez à rien et fermez le fichier. 
 
Si vous souhaitez avoir un paysage vierge, comme pour la suite de ce tutoriel, 
effacez ces éléments. Votre fichier devrait avoir cette allure maintenant : 
 

 
; === Surface Base === 
Name = P1 
Name = Habana 
Size = 1000 
MapObjectsToSphere = TRUE 
 
; === List of visuals === 
BEGIN_OBJECTLIST 
 
END_OBJECTLIST 

 

 
; === Surface Bases === 
BEGIN_SURFBASE 
P1: 60 18 
END_SURFBASE 

 

 
BLOCK 
 POS 40 0 220 
 SCALE 60 25 40 
 TEX1 Fcd02 4.125 2 
 TEX2 Fcd02 4.125 2 
 TEX3 Roof01 3 2 
END 
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Sauvegardez et fermez ce fichier. Si vous voulez assurer le coup, faites en une copie 
avant d’effacer les éléments, mais si vous faites les choses comme il faut, rien de 
grave ne devrait arriver… 
 
Attention à un détail ! Allez dans le dossier Scénarios et ouvrez le fichier P1.scn . 
Recherchez dans le bas du fichier la partie concernant le Deltaglider posé sur 
Iapetus. 
  

 
GL-01S:DG-S 
  STATUS Landed Iapetus 
  BASE P1:2 
  HEADING 5 
  PRPLEVEL 0:0.3 1:1 2:0.3 
  GEAR 1 1.0 
  NOSECONE 0 0.0000 
  NAVFREQ 562 162 50 0 
  TANKCONFIG 1 
  PSNGR 1 2 
END 

 
A la ligne BASE P1 :2, effacez le :2 marqué ici en rouge. Pourquoi donc ? Vous avez 
effacé tous les éléments dans le fichier P1.cfg, y compris les PAD sur l’un desquels 
était posé le Deltaglider, le 2 pour être précis. Dans ce fichier P1.scn, cette ligne 
indique que l’appareil est posé sur le PAD 2. Or celui-ci n’existe plus ! Si vous 
n’effacez pas cet élément, c’est le CTD (Crash To Desktop) assuré au lancement du 
scénario ! Sauvegardez puis fermez donc ce fichier.  
 
Lancez dans Orbiter le scénario P1. Vérifiez que le Deltaglider est toujours sur 
l’emplacement de la base P1, si ce n’est pas le cas, replacez le à cet endroit grâce à 
ScnEditor. (Ctrl+F4 → ScnEditor→ Location) 
 
Remarque :   Dans ScnEditor, à la page Location , il se peut que la base P1 soit 

sélectionnée, bien que l’appareil ne s’y trouve pas. Vous devez juste la 
resélectionner et il se retrouvera automatiquement à cet endroit.  

 
Vous remarquerez que tout a disparu ! Pourtant, la base existe toujours bel et bien. 
Regardez dans le MFDmap pour vous en convaincre.  
 
Une dernière chose : après avoir quitté Orbiter, retournez dans le dossier Scenarios 
et copiez le fichier (Current state).scn  dans le même dossier et renommez-le en 
paysage.scn  par exemple. Si le panneau de lancement d’Orbiter est toujours actif, 
fermer-le et rouvrez-le pour qu’il tienne compte du fichier scenario que vous venez 
de créer. Le scenario paysage  sera celui de base que vous utiliserez pour vos tests. 
Le scenario (Current state)  fonctionnera aussi par la suite, mais si vous en chargez 
un autre entre deux essais, il faudra rechargez le scenario paysage … Logique, 
non ? 
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Maintenant que vous êtes prêt, vous allez pouvoir commencer la modélisation du 
paysage à proprement parler. 
 
 

2. Préparer la textures de surface 
 
Laissez Orbiter de côté quelques minutes et ouvrez l’image de la surface dans 
Photoshop. Vérifiez au passage que votre plugin NVIDIA DDS est correctement 
activé.  
 
Réglez l’image qui est en « niveaux de gris » en mode « RVB » (Image→Réglage)  
 
Si vous avez un ordinateur correctement musclé, redimensionnez l’image en 
1024x1024 pixels au lieu des 1020x1020. 
 

Pourquoi ces dimensions ?  Parce que les textures sous le format DDS doivent 
avoir ce type de résolution (en pixel) : 4x4, 16x16, 32x32, 64x64, 128x128, 
512x512, 1024x1024, etc… Pour un paysage, c’est selon vos goûts et les 
performances de votre machine. Plus la résolution est élevée, plus la texture 
prendra de place dans la mémoire et ralentira votre ordinateur s’il a une 
configuration de matériel qui commence à dater. Dans ce cas, choisissez une 
résolution basse, comme 256x256, mais vous perdrez évidemment en qualité.  

 
Mais admettons que votre ordinateur fonctionne très bien et maintenez 1024x1024 
comme résolution.  
 
Dans le coin en bas à droite, cliquez sur l’onglet « couches », à côté de l’onglet 
« calques » : 
 

 
 
 
 
Vous pouvez voir les 3 couches qui composent 
l’image (Rouge, Vert, Bleu), ainsi que le tout 
superposé (RVB). 
 
 
 
 
 
 

 
Votre texture est très jolie, mais pour l’instant, elle ne passera pas dans Orbiter ! 
Enregistrez là en format *.jpg  avec comme nom, disons Sol1 .  
 
Ensuite, enregistrez-la à nouveau, mais cette fois en format *.dds . Si votre plugin est 
correctement activé, ce format doit être accessible lorsque vous faite « Enregistrer 
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sous… ». Appelez le également Sol1, c’est très important !  Lorsque vous cliquez 
sur « Enregistrer », la boîte de dialogue du plugin s’ouvre. Vous devriez obtenir ceci : 
 

 
 
Dans la boîte de dialogue, choisissez le mode :  
 
« DXT5 ARGB 8 bpp | Interpolated alpha » 
 
Cliquez sur « save ». Rien ne semble avoir bougé… Fermez votre image dds et 
rouvrez-la directement. 
 
Dans l’onglet « Couches », une nouvelle couche a fait son apparition ! Il s’agit de la 
couche alpha . 
 

 
 

Qu’est ce que la couche alpha ? La couche alpha définit le niveau de 
transparence de la texture dans Orbiter. Le blanc indique une opacité totale (la 
texture est visible), le noir une transparence totale (la texture est invisible). Les 
niveaux de gris entre les deux indiquent le degré de transparence. C’est grâce à 
cela que vous allez pouvoir faire une jolie insertion de votre paysage sur la 
surface de la planète. 
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Mettez-la visible et masquez les autre couches RVB. Vous vous retrouvez avec une 
fenêtre blanche, ce qui est logique puisque la texture est entièrement « visible » pour 
le moment. 
 

 
 
Prenez le pinceau, de gros diamètre et de dureté minimale et peignez le bord de la 
textures en noir. Prenez garde que la couche alpha est sélectionnée, et non les 
couches RVB ! Sinon, ça va faire moche… ;-) Si vous êtes plus ou moins talentueux, 
vous devriez obtenir quelque chose de ce genre : 
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Vous pouvez montrer toutes les couches ensembles et ainsi vous pouvez visualiser 
quelle partie de la textures sera cachée :  
 

 
 
Notez que vous pouvez toujours retoucher la couche alpha dans ce mode, mais c’est 
plus compliqué de voir ce qu’on fait exactement.  
 
Voilà, pour le moment, enregistrez votre travail, les retouches finales seront pour 
plus tard. 
 

3. Créer le relief 
 
Passons au relief maintenant ! Ouvrez Anim8or et créez une nouvelle scène 
(File→New). Si vous voulez, vous pouvez vous amuser un peu, histoire de le prendre 
en main, mais dans ce tutoriel seules les manipulations indispensables à la création 
de paysages seront mentionnées. 
 
Avant toute chose, il faut savoir changer de vue dans Anim8or : 
 
Ctrl+R : Un cercle vert apparaît et vous pouvez : 
 

- bouger  (bouton droit maintenu) 
- tourner  (bouton gauche maintenu)  
- zoomer  (roulette maintenue enfoncée et mouvement de la souris)  
 
Vous ne pouvez rien éditer dans ce mode. Refaites Ctrl+R pour le 
quitter. 

 
NumPad Plusieurs points de vue sont prédéfinis (face, haut, droit, etc…) et 

sont accessibles par les chiffres du pavé numérique.  
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Une fois cette mise au point faite, créez un cube avec l’outil « cube ». Double cliquez 
sur votre création. Entrez comme dimension (size) X et Z 100. La hauteur Y n’est pas 
importante, mettez 2 par exemple. Dans division, mettez 20 pour X et Z et laissez 1 
pour Y. Dans Anim8or, X et Z sont les axes du plan, et Y est la hauteur. 
 

 
 
Avec la touche 8 du NumPad (Top), on voit le quadrillage sur le cube produit par les 
20 divisions de chaque axe. 

 
Allez dans Build→Convert to Mesh. Cette opération a pour but de transformer l’objet 
en forme éditable à volonté. Le cube sélectionné passe du jaune au blanc, entouré 
de bleu. Passez maintenant en vue latérale (NumPad 4). Cliquez sur le bouton avec 
les trois points, puis prenez le rectangle de sélection comme outil et sélectionnez les 
points du bas pour les supprimer (Delete). Vous obtenez un plan et non plus un 
cube.  
 

 
 



Tutoriel : Création de paysages – Par Jekka Orbiter 2006p1  
 

  15/26 

 
Ceci fait, cliquez sur l’icône à 4 boules pour ajouter la texture. Une bande apparaît 
sur la droite de la scène. Double-cliquez sur la case « New » pour ouvrir la fenêtre  
« Material Editor ». Cliquez sur le bouton avec un trait, au niveau de la ligne 
« Diffuse » pour ouvrir la fenêtre « Texture selector ». Dans cette fenêtre cliquez sur 
« Load Texture » et aller chercher le fichier Sol1.jpg que vous avez créé toute à 
l’heure. Il apparaît alors dans la liste des textures. Sélectionnez et cliquez sur Ok. 
Retour à la fenêtre « Material Editor ». Avant de cliquez sur ok, changez le nom du 
material01 par Sol1. C’est plus propre… ;-). 
 

 
 

Ensuite, passez en vue TOP (NumPad 8). Cliquez sur le bouton avec la flèche en 
haut à gauche, sélectionnez le plan en cliquant dessus, puis cliquez sur « Apply » 
pour lui appliquer la texture Sol1. Pour visualiser le résultat en plein, sans fil de fer, 
cliquez sur la sphère à côté des l’icône des textures. Si vous avez tout fait juste, vous 
devriez obtenir ceci : 
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C’est très joli, tendance Art Moderne, mais c’est pas tout à fait ça. Pour améliorer les 
choses, cliquez sur le bouton marqué « UV ».  
 

 
 
Le carré jaune représente la texture, comme s’il s’agissait d’une feuille de papier qui 
bougeait à la surface du plan. Il s’agit en fait du mode de plaquage de la texture sur 
le plan. Les commandes à la souris sont les mêmes que lorsque l’on change l’angle 
de vue. Déplacez donc avec le bouton droit enfoncé le carré jaune de sorte à ce qu’il 
coïncide parfaitement avec votre plan. Si vous avez de la chance, le carré jaune peut 
être déjà ajusté au plan. Si vous faites une fausse manipulation, il vous suffit de 
cliquer sur un des boutons au dessus de « UV » et de recliquer dessus pour 
réinitialiser le mode de plaquage. 
 
Une fois que c’est bon, retournez dans le mode d’édition de point (bouton « trois 
points »), puis cliquez sur le bouton « cube plein » à côté de la sphère pour visualiser 
à la fois la textures et le fil de fer (changez de mode d’affichage une ou deux fois si la 
textures n’est pas visible malgré le fait que le bouton soit enfoncé). Ceci fait, 
enregistrez ce plan. 
 
Maintenant, laissez parler votre créativité, et votre habilité par la même occasion ! A 
l’aide des outils à disposition, sélectionnez les intersections et modifiez la forme pour 
qu’elle reflète bien les formes des structures géologiques de l’image. Il n’est pas 
possible de vous guider pas à pas pour cette opération qui est complexe mais en 
bidouillant et en s’entraînant vous attraperez le coup. N’oubliez pas que vous pouvez 
toujours faire Edit→Undo (ou Ctrl+Z) un certain nombre de fois pour annuler vos 
erreurs. Notez l’outil « couteau de boucher » qui permet de scinder des polygones en 
deux si cela s’avère nécessaire ou si le polygone a une forme bizarre, mais faites 
plusieurs essais avec différents outils. Et si votre « œuvre » est irrécupérable, vous 
pourrez toujours recharger le plan de départ. 
 
Une bonne technique pour obtenir de bons résultats, c’est de toucher uniquement à 
la hauteur de certains points stratégiques. On peut bloquer le déplacement en X et Z 
et de déplacer les points que sur l’axe Y. En tranchant les carrés qui ont une forme 
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bizarre, sur les pentes notamment, on arrive à quelque chose de joli, tout en restant 
simple et en se fatiguant un minimum. 
 
Suivant votre adresse ou votre persévérance, vous devriez arriver à obtenir quelque 
chose de ce style :  
 

 
 
Sauvegardez votre création. Exportez-là ensuite en format *.3ds  en faisant  
Object → Export… Enregistrez le fichier Sol1.3ds . On touche au but ! 
 

4.  Insérer dans Orbiter 
 
La partie la plus intéressante du travail arrive : le portage sur Orbiter ! Prenez les 
deux programmes 3DS2MSH et 3DS2MSH_GUI et mettez-les dans votre dossier 
paysage. Ouvrez le programme 3DS2MSH_GUI. Dans la première ligne, allez ouvrir 
3DS2MSH. Dans la deuxième, allez chercher votre fichier Sol1.3ds . Dans la 
troisième, vous aller donner le nom du fichier exporté ainsi que son dossier de 
destination. Il vous est proposé de l’appeler Sol1.msh . Très bon choix de la 
machine, conservez ce nom… 
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« Scale » est le facteur d’agrandissement du mesh. Souvenez-vous, dans Anim8or, 
vous aviez fait un carré de 100x100. Si on utilise un facteur 1, le carré fera 100m sur 
100m dans Orbiter. Un facteur 20 donne un carré de 2km sur 2km. Entrez cette 
valeur. Mettez sous « Axis order » l’ordre suivant des axes :  xzy . Rappelez-vous, 
sous Anim8or, l’axe de la hauteur est Y et non Z. A l’emplacement « UV », mettez 
seulement V. cela évite d’avoir la texture dans le sens inverse. Une fois que vous 
êtes prêt, cliquez sur « Convert ». 
 

Note : Si vous voulez une explication détaillée de la conversion des axes 
d’Anim8or à Orbiter, je vous conseille d’aller jeter un œil sur ce lien, Papyref 
explique dans les détails, avec image à l’appui, comment ça fonctionne : 
 
http://orbiter.dansteph.com/forum/read.php?f=5&i=640&t=611#reply_640 
 

 
Vous pouvez maintenant aller chercher le fichier Sol1.msh  dans le dossier de 
destination que vous aviez indiqué. Ouvrez-le et allez voir tout à la fin du fichier. La 
ligne suivante apparaît : 
 
 

TEXTURES 1 
Sol1.dds 

 
Il s’agit de la liste des textures que vous avez appliquées à la forme. Il n’y en a 
qu’une ici : celle que vous avez enregistrée auparavant en format *.dds. Allez donc 
copier votre fichier Sol1.dds  dans le dossier Textures  de Orbiter. 

 
Note :  Si vous voulez, vous pouvez faire un dossier Paysage  par exemple dans 
le dossier Textures et y mettre votre fichier. Il faudra alors corriger le chemin 
d’accès de cette manière : 

 
 

TEXTURES 1 
Paysage/Sol1.dds 

 
Ce n’est pas indispensable. Si vous faites ceci, chaque fois que vous 
convertirez le fichier 3ds, à cause de correction ou autre, il vous faudra chaque 
fois venir corriger l’adresse de la texture à la fin du fichier msh. Pour l’instant, ne 
faites pas cette opération. 

 
Fermez le fichier Sol1.msh  et copiez-le dans le dossier Meshes du répertoire 
principal d’Orbiter.  



Tutoriel : Création de paysages – Par Jekka Orbiter 2006p1  
 

  19/26 

 
Ouvrez le fichier P1.cfg  dans le dossier Config, celui où étaient déclarés les 
éléments visuels que vous avez supprimés. Ajoutez les lignes suivantes (bleues) : 
 

 
 
 
→ Type d’élément  
→ Nom du fichier msh dans le dossier Meshes. 
→ Position du mesh par rapport à la base 
→ Rotation du mesh 
 
 
→ Fin de la description. 
 
 
 

 
Sauvegardez et fermez ce fichier : Maintenant, allez enfin découvrir le résultat sous 
Orbiter… 
 

 
 
L’insertion semble réussie. La textures semble un poil trop claire. Reprenez le fichier 
Sol1.dds dans Photoshop et faites les retouches nécessaires (luminosité, teinte, 
etc..) 
 

 
; === List of visuals === 
BEGIN_OBJECTLIST 
MESH  
 FILE Sol1 
 POS 0 0 0 
 ROT 0 
 OWNMATERIAL 
 PRELOAD 
END 
END_OBJECTLIST 
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Suivant les ombres de l’image d’origine, vous pouvez égalent aller régler dans le 
fichier P1.cfg  la rotation du mesh pour que les lumières soient cohérentes. 
Retournez-le de 180° par exemple : 
 
Après retouche et réglage de la position, voici le résultat obtenu :  
 

 
 
 
En regardant de plus près, on voit que le Deltaglider a des problèmes. Comme 
l’appareil est théoriquement posé à la surface de Iapetus, la hauteur du mesh n’est 
pas idéale. De plus, il est dans une pente. Un terrain plat comme site d’atterrissage 
semble plus indiqué.  
 

 
 
Il faut corriger la position du mesh toujours dans le fichier P1.cfg. A la ligne suivante, 
ajustez les valeurs pour avoir quelque chose de correct.  
 

Dans Orbiter, l’ordre des axes est le suivant : 
 
X (Longueur)    Z(hauteur)   Y(Largeur)   
 

 
Les valeurs suivantes font l’affaire : 
 
-400 -23 -400 

 
POS 0 0 0 
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Maintenant, le Deltaglider est sur un terrain plat, les roues touchent le sol, et voilà ! 
Vous avez créé votre premier paysage pour Orbiter ! Félicitations ! 
 

 
 
Vous pouvez maintenant préparer une archive en zip ou en rar. Les fichiers à y 
mettre sont :  - Iapetus.cfg 
   - P1.cfg     
   - Sol1.dds 
   - Sol1.msh 
   - Paysage.scn 

 
 
FIN DE LA PREMIERE PARTIE
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DEUXIEME PARTIE 
 

Recherche de la perfection…  (niveau avancé) 

 
Vous venez de créer un environnement magnifique, cependant, si vous regardez de 
plus près, il y a quelques aspects qui ne sont pas encore tout à fait au point… Deux 
pour être plus précis : le terrain est passablement pixellisé lorsqu’on le voit de près, 
et le Deltaglider n’a pas d’ombre portée à la surface… 
 
Si ces détails ne vous dérangent pas, passez votre chemin. Si en revanche, vous 
voulez améliorer votre environnement, c’est par ici ! 
 
Attention, dans la suite de ce tutoriel, nous allons considérer que vous avez assimilé 
les principes d’édition et les procédures. Les descriptions des étapes seront donc 
plus courtes et simplifiées. Si vous avez un problème, n’hésitez par à reprendre la 
partie concernée dans le chapitre précédant. 
 
L’idée est de faire  un trou dans la texture du premier mesh, et d’y placer un second, 
avec une texture plus fine. 
 
 

1. Créer une seconde texture 
 
Il faut cette fois créer une texture plus proche de ce à quoi pourrait ressembler le sol 
de près. Une solution est de chercher une image de sol qui corresponde à 
l’environnement général. Une autre est d’en créer une de toutes pièces à partir de 
l’image de base grâce à Photoshop. En augmentant la résolution à 2048x2048 et du 
fait de la taille réduite du mesh dans Orbiter, le résultat sera assez fin.  
 
Vous obtenez une texture dans ce style :  
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Enregistrez cette texture comme Subsol1 en *.jpg et en *.dds. Pour le format *.dds, il 
n’est pas nécessaire de convertir en DXT5 Interpolated alpha. Choisissez DXT1 no 
alpha, cela ira très bien. 

2. Créer un second mesh 

 
Dans Anim8or, créez à nouveau un plan, comme expliqué au chapitre précédent, 
section 3. Mais cette fois, pas besoin de le diviser par 20. Laissez 1 comme valeur 
pour chaque division. Plaquez-y votre nouvelle texture. 
 
Nommez le Subsol1  et exportez le plan en *.3ds, puis convertissez-le en *.msh. 
Dans 3DS2MSH, il faut tâtonner, mais un agrandissement de 6 (scale) est bien. 
 

3. Modifier la première texture (Sol1.dds) 

Reprenez le fichier Sol1.dds dans Photoshop. Toujours avec le pinceau en utilisant 
une dureté minimale, peignez une surface autour de l’emplacement du Deltaglider 
dans Orbiter. Pour savoir où le situer, l’idéal est d’avoir une capture d’écran du 
paysage sous Orbiter à côté de votre travail : 

 

Le Deltaglider, si vous ne l’avez pas bougé, est théoriquement pile au centre de la 
base, au point ayant les coordonnées « 0 0 0 », malgré le fait qu’il est excentré par 
rapport au mesh. Il sera donc très facile d’incorporer le second plan, il devra se 
trouver aux coordonnées « 0 0 0 » ! 

Sauvegardez-le en *.dds DXT5 Interpolated alpha . Appelez-le Sol1trou.dds par 
exemple. 
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4. Porter sous Orbiter 
 
Maintenant, placez le fichier Subsol1.msh dans le dossier Meshes et les deux 
fichiers Subsol1.dds et Sol1trou.dds dans le dossier Textures. 
 
Dans le fichier Sol1.msh, allez à la fin et changez le nom de la texture Sol1.dds en 
Sol1trou.dds. 
 
Dans le fichier P1.cfg, ajoutez les lignes suivantes (en bleu) : 
 

 
 
 
→ Premier mesh 
→ Changez le nom de la texture 
→ 
→ 
→ 
→ 
→ Fin de la description 
→ Nouveau mesh 
 
 
 
 
→ Indique que les engins ont une ombre portée 
sur ce mesh ! 
 

 
 

 
Pourquoi ne pas mettre UNDERSHADOWS tout simplement  sur le premier 
mesh ?  Lorsque cette option est activée sur un mesh en 3D, elle occasionne 
des bugs de collision très inesthétiques. En revanche, sur un simple plan 
comme le deuxième, il n’y a aucun problème. 

 
Vous aurez peut être deux-trois ajustements de position à faire, selon la nature de 
votre mesh principal ou de votre texture. 
 
 
 
 
 
 
 
 

 
; === List of visuals === 
BEGIN_OBJECTLIST 
MESH  
 FILE Soltrou1 
 POS -400 -23 -400 
 ROT 180 
 OWNMATERIAL 
 PRELOAD 
END 
MESH  
 FILE Subsol1 
 POS 0 0 0 
 ROT 180 
 OWNMATERIAL 
 UNDERSHADOWS 
 PRELOAD 
END 
END_OBJECTLIST 
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Si tout s’est bien déroulé, vous devriez avoir quelque chose de ce genre dans 
Orbiter : 

 

 
On voit que le sol est plus fin et que le Deltaglider a une ombre ! C’est quand même 
plus zoli qu’avant, non ? ;-)  
 
Vous l’aurez peut être remarqué, une texture en haute résolution ralentit 
passablement Orbiter. Si votre machine n’est pas très performante, limitez-vous à 
des résolutions plus basses. 
 
Il y a  encore la possibilité d’améliorer votre paysage en y ajoutant des rochers, 
toujours via le fichier P1.cfg. Mais vous n’avez plus besoin de tutoriel pour le faire 
maintenant… ;-) 
 

 
 
 
Bonne continuation dans vos créations, et venez les  présenter sur 

le forum de Dansteph ! 
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Note :  Les fichiers créés pour ce tutoriel figurent dans l’archive annexe. Vous pouvez 
les étudier de près si vous avez des problèmes. Attention toutefois si vous le 
décompressez dans votre dossier Orbiter, vous risquez de perdre vos travaux si 
vous les avez nommés  selon ce qui est indiqué dans ce document ! 
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